Economic Analysis
1st level Analysis

• This includes many of the most popular metrics like Simple Payback and Simple Rate of return. This level of analysis is not recommended as standard practice by the IES (RP-31)

• Benefits
  • Fast
  • Simple to calculate
  • Familiar

• Drawbacks
  • Can be misleading (the fastest payback may not be the best value)
  • Energy only analysis can miss substantial maintenance savings/costs
  • Does not include the time value of money
Simple Economic Tool

- Quick go/no-go analysis
- Designed with mobile devices in mind
- Energy only, no time value of money
- Smart hours field detects if hours are per day or per year
- Optionally toggle on/off controls & rebates
- Smart rebate field will do simple math
- www.visual-3d.com/tools/payback/
Simple Economic Tool

• Enter in wattage, quantity, and purchase cost
• Existing luminaires should be entered in the baseline
• Existing luminaires should have a cost of $0 since they have already been purchased
Simple Economic Tool

• Click ‘Add Control’ to show control fields
• Click ‘Add Rebate’ to show rebate fields
• Hiding controls/rebates removes them from the calculation
• Use the value field to do math for your rebate eg \((450 \times 365) - (400 \times 240)) \times 0.5\) to get the value of a demand reduction credit of 50 cents per kWh between designs
Simple Economic Tool

- Click print to open the printed report
- You must allow pop ups from visual-3d.com
- Print url is shareable, just copy paste to email the report
Who should be doing economic analysis?

• Demonstrating the long term cost savings of energy efficient luminaires is a worth while task in all walks of the lighting industry

• Specifiers: can use an analysis to defend aspects of their design (eg energy saving controls) from being ‘Value Engineered’ off a project

• Manufacturers / Reps / ESCOs: can use long term efficiency savings as a sales tool

• Owners /Owner Reps: should understand and be able to verify claimed savings
2nd Level Analysis

• Takes into account the time value of money, looks at a greater range of costs such as those related to maintenance. Common 2nd Level Analysis metrics include, Life Cycle Cost, Internal Rate of Return, Net Present Value

• Benefits
  • More ‘realistic’ analysis
  • Ability to see the value of making one decision over another
  • The IES recommended practice

• Drawbacks
  • Less familiar terms
  • More complicated calculations

• The Visual Economic Tool 2.0 performs 2nd level analysis

\[ PV = \frac{FV}{(1 + i)^n} \]
What is the Time Value of Money?

- Would you rather I give you $10,000 today? Or $10,000 5 years from now?

- If you got the money today, you could use it today, or start investing it today. If you invested that money (wisely), you would likely have more than $10,000 dollars in 5 years.

- The Discount Rate (i), sometimes called the ‘Opportunity Rate’ or ‘Owners Cost of Money’ or ‘Cost of Capital’ allows for comparison of cash flows from different time periods.

- A high discount rate places emphasis on initial costs and lessens the value of future costs. A low discount rate places more emphasis on future events.

- In general the discount rate used should be as close as possible to the cost for the owner to borrow money, however, if information about the owners cost to borrow is not available a ‘prime’ interest rate can be used (3.25% at the time of writing)

![Figure 3.4: Present Value of $500,000 in 10 years](image-url)
Visual Economic Tool 2.0

• Compare up to 3 designs across multiple spaces. You can include multiple luminaire types in each design.
• Save your progress to work on it later in a .VETX file
• Print customizable reports
• Uses a luminaire schedule to track all defined luminaires
Economic Tool Concepts Organization

- An Economic Tool project may consist of one or more Project Spaces
  - A Space can be a physical room, or a group of rooms or areas that have the same operating hours and labor rates

- Within each Project Space there are three Design Options, a Baseline and up to two alternate designs that will be compared to the Baseline.

- In each Design Option there can be many different Luminaires, Controls, and or Rebates
Economic Tool Concepts Results

- The Design options can be analyzed across all project spaces, within groups of spaces, or within an individual space.

- Dividing your project into spaces allows for assumptions to be more specific and for comparison between spaces.
Changing from 1.0 to 2.0

- If you have used version 1 you are already familiar with the core concepts used in version 2.

- In version 1 you were essentially limited to 1 space. Each column was a ‘Design Option’ limited to one luminaire type.

- The left hand assumption column is now split between assumptions you make at the space level, and at the project level in the results screen.

- Version 2 breaks down the user input into easier to read and understand windows instead of one big column.
Example 1: Simple Project

• Goals:
  • Get familiar with the Economic Tool 2.0
  • Perform a quick energy only analysis
  • Understand the results
Example 1: New Project

- Launch a new project by clicking the Start button
- When you start a new project, a default project space is created.
Example 1: Editing Default Space

- Edit the fields the default space
- Name: Example 1
- Description: Simple energy only example
- Weekday Hours: 10
- Weekend Hours: 10
- Set all Labor Rates to: 0
- Click Save
- After your changes are saved, your space is highlighted in the Project Spaces List
- If you need to go back and make changes to a space, highlight its row and click Edit Space. Or double click the row.
Example 1: Adding Baseline Luminaire

- Click the Add Luminaire button in the baseline Design Option
- This opens the Plan Luminaire window. This window is used to Add or Edit Luminaires in each Design Option.
- Adjust Quantity
- Enter a new Luminaire definition
- Select a previously defined Luminaire
- Select IES files
Example 1: Adding Baseline Luminaire

- Change Quantity: 100
- Add Label: Ex1-A
- Add Description: Existing
- Change Wattage: 100W
- Click Save
Example 1: Adding Proposed Luminaire

- Click Add Luminaire in Design #2
- Change Quantity: 100
- Add Label: Ex1-B
- Add Description: Lower Wattage Alt
- Change Wattage: 50W
- Change Cost: $100
- Click Save
Example 1: Results Overview

- Click the Results button
- The Results page
- Edit Project Assumptions (electricity rate)
- Results Types
  - Project Wide Design Option Results
  - Group Wide Design Option Results
  - Space Design Option Results
  - View individual, average, total years
  - View Luminaire Quantities
- Design Audit (warning messages)
Example 1: Design Results

- Change the Assumptions
  - Life Cycle : 10 years
  - Discount Rate: 3%
  - Electricity Rate: 10 cents
  - Sales Tax : 0%
  - Income Tax Rate: 0%

- Accumulated Present value stacked column chart

- Design Summary Metrics
  - Life Cycle Cost
  - Net Present Value
  - Simple Payback
  - Discounted Payback
  - Internal Rate of Return
Example 1: Average Year

• Change to the Annual Detail tab
  • On this tab you can view details from each year of the life cycle as well as the average operation year, and the accumulated Total year

• Select the Average Year from the Year dropdown

• Because we only provided information about energy cost, we only see information about energy costs in the results. As we would expect, the proposed design, with half the wattage, has half the annual electricity cost
Example 1: Fv v PV

- Click the FV v PV tab
- This table contrast the future and present values of each of analysis.
- As expected the present values diminish slightly over time due to the discount rate
- Present values are calculated from the Future values

\[
PV = \frac{FV}{(1 + i)^n}
\]
Example 1: Design Audit

- Click the Design Audit Tab
- The design audit tab lists warnings for spaces, design options and luminaires.
- The audit attempts to point out what could be mistakes in your project
- When we started our project, we cleared out labor costs, the audit is just reminding us that no labor costs are being calculated for our space
Example 2: Manufacturing Facility

- In this example we will build a project for a manufacturing facility with 3 spaces.
  - Manufacturing Space
  - Warehouse Space
  - Office Space

- Each space has unique lighting requirements

- The Existing lighting sources are
  - Manufacturing: 30 320w MH Highbay & 12 8’ T12 strips
  - Warehouse: 18 250w MH Highbay
  - Office: 15 2 lamp t8 2x2 (71w total)

- The Proposed Luminaires
  - Manufacturing: 30 LED Highbay (250w) & 24 4’ t5 strips
  - Warehouse: 18 Highbay (200w)
  - Office: 15 LED (38w)
Example 2: Opening a File

• To save time we are going to load in a file that already has the luminaires and spaces defined. We will then associate the luminaires with the appropriate Design Options

• The file is linked on the start page of the tool
Example 2: Luminaires

• Change to the Luminaire Schedule tab so we can review what luminaires exist in the file

• In the Luminaire Schedule you can Add, Copy, and Delete luminaire definitions. You can edit multiple rows by checking the selection box for each row you want to edit.

• You can sort the grid by any column.

• You can use the filter dropdown to sort by Design Option, however, right now all Design Options are empty.
Example 2: Luminaire Maintenance

- Select the rows of Luminaires A, B, C by clicking the selection box at the start of each row.
- In the fields below, change the relamping type to All at Rated Life.
- Click Save to apply the change to the luminaires.
- This will wait until the LEDs reach their rated ‘lamp life’ and then replace the whole luminaire. We account for the cost of a new luminaire by entering the luminaire cost in the lamp cost field. This is one way to account for luminaire lifetime for LED luminaires.
Example 2: Manufacturing Baseline

• Change back to the Design tab

• Select the Manufacturing Space

• Click Add Luminaire in the baseline Design Option
  • This fills in all fields with the previously defined luminaire information

• Set the quantity to 30

• Click Save
Example 2: Manufacturing Baseline

- Click Add Luminaire again, this time we will add 12 of the t12 strip lights
- Change the Quantity to 12
- Select the EX4 luminaire from the Label dropdown
Example 2: Warehouse Baseline

• In the Project Spaces list, select the Warehouse row
• In the Baseline Design Option, select Add Luminaire
• Change the quantity to 18
• Select the EX2 Luminaire
• Click Save
Example 2: Office Baseline

- In the Project Spaces list, select the Office row
- In the Baseline Design Option, select Add Luminaire
- Change the quantity to 15
- Select the EX3 Luminaire
- Click Save
Example 2: Baseline Complete

- We have now defined our Baseline Design Option, and we already have the proposed replacement luminaires defined.
- We could enter in each replacement in the same way we entered the baseline.
- Instead, let's use the Alternate Design Creator.
Example 2: Alternate Design Creator

• The alternate design creator is for quickly swapping out luminaire types between designs.

• This is a great way to move from an existing audit to a proposed design with very few clicks.

• In the EX1 row, in the Design #2 column, select Luminaire C.
Example 2: Alternate Design Creator

- In the EX4 Row select Luminaire D
- The quantity from EX4 is automatically copied over, usually, if you are doing a 1 for 1 replacement, that is fine. However, changing from 8’ luminaires to 4’, we need to change the quantity from 12 to 24. Just click in the Quantity cell and type in 24
- Continue selecting replacements
- EX3 -> Select Type A
- EX2-> Select Type B
- When all replacements have been entered, click Save Changes.
Example 2: Design 2 Complete

- After replacing the luminaires, you are returned to the Design tab
- We can see our Design #2 has been filled out with the types and quantities we specified
Example 2: Add Control

- Select the Office Space
- Click ‘Add Control’
- Select Lumen Management control type
- Enter in relevant information
- Because the control is integrated that cost and install time are zero
- Select Type A from the controlled luminaires grid
Example 2: Add Another Control

- Select the Warehouse Space
- Click ‘Add Control’
- Select Occupancy control type
- Enter in relevant information
- The warehouse space will need two occupancy controls
- Make sure type B is selected
Example 2: Control Reductions

- Change to the Reduction Factors tab
- Adjust the weekend hour reduction to .35
- Click save to add the control
Example 2: Add Rebate

• Select the Warehouse Space
• Click ‘Add Rebate’
• Enter a Name for the rebate, this will show up in the Label column
• Enter a value of 350. this will be evaluated as a credit offsetting some of the initial costs. Negative values are interpreted as additional costs.
• Enter a Reason, this will be displayed in the detail column and in the print out
• You could enter a Quantity to multiply the rebate, eg $15 per luminaire type A, and then use the Quantity of type A luminaires.
Example 2: Results

- We can view the results across all three spaces
Example 2: Groups

- Because the spaces have been put into two groups, we can see the results of each group.
Example 2: Spaces

• We can view the results across each of the three spaces
Example 2: Average Year

- You can review the results for individual years in the analysis period on the annual details tab.
- From the year drop down you can select the Average Year.
- Here you can see the electrical and maintenance savings of the lighting controls are called out.
Example 2: Printing

- Select File > Create Report to open the report set up page
- You can enter information that will be displayed on the cover page
- On the print out you can select what pages will be printed to customize your report. After changing your selected pages, View Report pages to open the report in a new tab
- You can preview pages by highlighting a row in the selected pages grid and clicking View Selected Page
- Most of the printed pages correspond directly to portions of the Results tab
Example 2: Printed Pages

- Some examples of the printed pages
- Cover page with project information
- Executive Summary
- Average Operating Year Comparison
- Cash Flow Analysis
Example 2: Printing to PDF

- In your browser Select Print -> Print Preview
- If you see any extra header or footer information, you can turn that off in settings
- Select a PDF printer. If you don’t have one, we use CutePDF which is free and works well
Quick Replace

• Swap out one type for another
  • In all project spaces or just one
  • In all designs or just one
• Select a design to perform the replacement
  • If its all designs, its replaced in all designs
  • If it’s the same as the existing, all occurrences will be replaced
  • If its different, a new luminaire will be added using the same quantity as in the source design
• Result Preview shows what the result will be when you click confirm
Design Settings

- Rename Design Options
- Swap what Design Option is the baseline
  - The baseline is always the left most design
  - Savings calculated in results are in comparison to the baseline design
  - It should be the existing design, or the highest kWh proposed design if all design options are proposed.
- Copy a Design Option or clear out a Design Option